UnderstandSCI.com: A Patient-Centered, Educational Website for Spinal Cord Injury Rehabilitation

by
Katelyn McDonald

A thesis submitted to Johns Hopkins University in conformity with the requirements for the degree of Masters of Arts

Baltimore, Maryland
March, 2014

© 2014 Katelyn McDonald
All Rights Reserved
Abstract

In 2013, the National Spinal Cord Injury Statistical Center estimated there could be as many as 332,000 people living with spinal cord injuries (SCIs) in the United States with an estimated 12,000 new SCIs each year. Every SCI patient has different nerve fibers damaged and a unique medical background that requires an individualized education.

The Comprehensive Integrated Inpatient Rehabilitation Program, located at MedStar Good Samaritan Hospital in Baltimore, MD, and staffed by Johns Hopkins Physical Medicine and Rehabilitation faculty, has an interdisciplinary team that utilizes the expertise of physiatry (rehabilitation medicine), rehabilitation psychology, speech language pathology, occupational therapy, physical therapy, and nursing. This team is tasked with communicating the complex anatomy and physiology of SCIs and associated complications to patients.

Educational materials for SCI patients have been predominantly text-based with line drawings, and therefore, dependent on the literacy levels of consumers. More recently, online visual aids have been developed to enhance learning opportunities by enabling users to interact with educational material across multiple modalities (e.g. visual, auditory, touch). However, these visual aids are not currently available for SCI patients in a comprehensive, reliable form. The purpose of this project was to develop an educational website that conveys medical information to SCI patients and families.

The creation of the website began with a needs assessment to gather as many opinions as possible to determine where dynamic visual assets in the education of SCI patients are most needed. Once the topics on which to focus were chosen, a combination of three-dimensional models and two-dimensional illustrations were created to complete five interactive modules, five animations, and one interactive WebGL model. These visual solutions were combined into a responsive Wordpress template. The website is touchscreen compatible and can be easily accessed using a variety of devices, including desktops, laptops, tablets, and smart phones.

UnderstandSCI.com is a web-based educational tool designed to engage patients in the learning process through illustrations, animations, and interactive features. This project offers rehabilitation providers a resource to convey information about SCI and relevant secondary complications to patients and families.

Katelyn McDonald
Chairpersons of the Supervisory Committee

Jacob Bentley, PhD, *Thesis Preceptor*
Assistant Professor, Department of Physical Medicine and Rehabilitation, Division of Rehabilitation Psychology and Neuropsychology, Johns Hopkins University School of Medicine, MedStar Good Samaritan Hospital

Jennifer Fairman, MA, CMI, FAMI, *Departmental Advisor*
Assistant Professor, Department of Art as Applied to Medicine, Johns Hopkins University School of Medicine

Lydia Gregg, MA, CMI, FAMI, *Content Advisor*
Instructor, Division of Interventional Neuroradiology, Department of Art as Applied to Medicine, Johns Hopkins University School of Medicine
Acknowledgements

This project would not have been possible without the collaboration and support of so many individuals. I would like to thank my faculty advisor, Jennifer Fairman, MA, CMI, FAMI, for her day-to-day guidance and accepting my constant interruptions with a smile.

This project was born from the enthusiasm of Jacob Bentley, PhD and was only completed because of his continual assistance in moving the project forward.

Lydia Gregg, MA CMI, FAMI was a constant source of help, guidance, and advice for every step of the process.

The staff, faculty, and students in the Department of Art As Applied to Medicine at Johns Hopkins University School of Medicine were an invaluable support network. In particular I would like to thank Corinne Sandone, MA CMI, FAMI for helping me with the struggles along the way, Gary Lees, MS, CMI, FAMI, for always reviewing my content when I needed another opinion, David Rini, MFA, CMI, FAMI for his assistance in every 3D modeling question, Mike Linkinhoker, MA, CMI for guiding me through the challenges of Adobe Edge Animate, Sarah Poynton, PhD for her advice in scientific writing and presenting, Dacia Balch for being there for the students in every way possible, and all of the students of the Classes of 2013, 2014, and 2015 for their advice and encouragement.

The SVG interactivity of the website would not have been without the help of Simon Widjaja and Edge Docks.

I would like to extend my appreciation to the MedStar Good Samaritan staff that so generously reviewed content. Special thank-yous to Kevin Platt, PT, MBA for organizing the funding and purchasing everything needed to make this website possible, Elise Egolf, PT for her review of content and organizing her peers for a massive review, Kenneth Silver, MD for continuous diligent review of content, and Theresa Alexander, SLP, Sharron Baker, RN, Jacqueline Dimon, OT, and Sandeep Singh, MD for their feedback.

This website would not have been possible without the amazing feedback from patients willing to share their stories.

Thank you to the Vesalius Trust for financially supporting me through the Student Research Grant.
I also thank my family and friends for supporting me through the long years of my education. I cannot thank my boyfriend, Jake Trullinger, enough for being there everyday supporting me. My family, Gareth McDonald, Amanda Li, PharmD, Annette McDonald, and A.P. McDonald, have always given me support in every way from the mundane, reading of my content, to the extraordinary, building me a computer and tracking down rare anatomical atlases. Last, but not least, I would like to thank Shannon Mcclintock for the gift of the anatomical atlas that was my daily reference and companion.
# Table of Contents

Abstract....................................................................................................................................... ii  
Chairpersons of the Supervisory Committee ........................................................................... iii  
Acknowledgements .................................................................................................................... iv  
Index of Figures ........................................................................................................................ vii  
Introduction ............................................................................................................................... 1  
   Objectives ................................................................................................................................. 3  
   Audiences ................................................................................................................................. 4  
Materials & Methods ................................................................................................................. 5  
   Needs Assessment ..................................................................................................................... 5  
   Content Planning ...................................................................................................................... 7  
   Visual Asset Development ....................................................................................................... 9  
   Interactive Module & Animation Development ....................................................................... 18  
   Audio Recording & Editing ...................................................................................................... 18  
   Website Development ............................................................................................................ 24  
Results ...................................................................................................................................... 33  
   Access to Assets Resulting from this Thesis ........................................................................... 42  
Discussion ................................................................................................................................ 43  
   Future of UnderstandSCI.com ................................................................................................. 47  
Appendices ................................................................................................................................ 49  
   Appendix A: Narrations .......................................................................................................... 49  
   Appendix B: Storyboards .......................................................................................................... 54  
References ................................................................................................................................ 66  
Vita .............................................................................................................................................. 68
Index of Figures

Figure 1. Three anatomical models ................................................................. 2
Figure 2. The flowchart of topics gathered from the needs assessment.................... 7
Figure 3. ZSphere armature of spinal cord before skinned .................................. 12
Figure 4. Unified Skin on ZSphere armature of spinal cord ................................. 12
Figure 5. Spinal cord model when Classic Skin was used over ZSphere armature .... 13
Figure 6. Window in ZBrush of the Classic Skin settings used .............................. 13
Figure 7. Sample of photographs used to produce 3D mesh in 123D Catch ............ 14
Figure 8. The model produced by 123D Catch................................................ 14
Figure 9. Model of brain as it first appeared when brought from 123D Catch into ZBrush 15
Figure 10. 3D surface render of stock CT Melanix in OsiriX ............................... 16
Figure 11. Object organization within Nulls in Cinema 4D ................................. 17
Figure 12. UnderstandSCI.com logo ............................................................... 17
Figure 13. UnderstandSCI.com favicon produced from the vertebral column in the logo 17
Figure 14. The audio as it initially appeared inside Audition ............................... 18
Figure 15. The audio in Audition after Noise Reduction ..................................... 19
Figure 16. “Save As” window in Illustrator with SVG format selected ................ 19
Figure 17. SVG Interactivity window in Illustrator with JavaScript code ............... 20
Figure 18. “yepnope” statement in “creationComplete” of Stage in Edge Animate 20
Figure 19. Statement in “creationComplete” of Stage in Edge Animate ................ 20
Figure 20. Statement in “creationComplete” of Stage in Edge Animate ............... 20
Figure 21. CSS “position” regulation in WebGL HTML code ............................ 21
Figure 22. Result of text path transition before it was optimized .......................... 23
Figure 23. Header section in the VamTam Layout tab of the Wordpress Dashboard 25
Figure 24. Footer section in the VamTam Layout tab of the Wordpress Dashboard 26
Figure 25. Final layout of the website footer with five widgets .......................... 26
Figure 26. The widgets used in the five footer widget areas ................................ 27
Figure 27. Global Colors section in the VamTam Styles tab of the Wordpress Dashboard 27
Figure 28. General Typography section in the VamTam Styles tab ................................................... 28
Figure 29. Edited Menus section in the Appearance Menus tab ........................................................... 29
Figure 30. SCI anatomy page with an option ......................................................................................... 30
Figure 31. Link selected in the VamTam Portfolio Format of the portfolio post ................................. 30
Figure 32. The Portfolio option selected in the VamTam Drag & Drop Editor of the page .......... 30
Figure 33. The Autonomic dysreflexia portfolio post selected within the Portfolio ....................... 31
Figure 34. HTML page produced by Edge Animate that initiates the interactive module ............... 31
Figure 35. Edge Animate header HTML pasted into the Wordpress HTML header ......................... 32
Figure 36. Edge Animate body HTML pasted into the Wordpress HTML body ................................. 32
Figure 37. Pages window in the Menus section in the Appearance Menus tab ................................ 32
Figure 38 A–D. How the homepage appears on different devices ..................................................... 34
Figure 39. Screenshot of Spinal cord function page in General anatomy ........................................... 35
Figure 40. Screenshot of Spinal cord anatomy page in General anatomy ............................................ 36
Figure 41. Screenshot of Motor neurons page in General anatomy ..................................................... 36
Figure 42. Screenshot of Dermatomes page in General anatomy ....................................................... 37
Figure 43. Screenshot of Myotomes page in General anatomy ............................................................. 38
Figure 44. Screenshot of Level of injury page in SCI anatomy ............................................................... 39
Figure 45. Screenshot of Complete vs. incomplete page in SCI anatomy .......................................... 39
Figure 46. Screenshot of Syndromes page in SCI anatomy ............................................................... 40
Figure 47. Screenshot of Syndromes page in SCI anatomy with the Brown-Sequard syndrome .... 41
Figure 48. Screenshot of Autonomic dysreflexia page in SCI anatomy ................................................. 42
Figure 49. Screenshot of Autonomic dysreflexia page in SCI anatomy with .................................... 42
Figure 50. Homepage of the Nemo Wordpress template ............................................................... 45
Figure 51. Two-column menu of the Nemo Wordpress template ......................................................... 45
Figure 52. Search icon in the Nemo Wordpress template ............................................................... 46
Figure 53. Search bar when activated in the Nemo Wordpress template ............................................. 46
Figure 54. Homepage of the David & Goliath Wordpress template .................................................... 46
Figure 55. Menu with tertiary capabilities in the David & Goliath Wordpress template ................. 47
Figure 56. Search bar in the David & Goliath Wordpress template .................................................... 47
Introduction

In 2013, the National Spinal Cord Injury Statistical Center estimated there could be as many as 332,000 people living with spinal cord injuries (SCIs) in the United States with an estimated 12,000 new SCIs each year. Recent advances in clinical practice and medical technology have lead to an increased survival rate of persons with SCIs (McColl et al. 1997). There are now more people living with SCIs than there have ever been in the past. Each individual with a SCI has a unique injury and therefore a unique recovery and rehabilitation. The level and extent of these injuries vary between individuals, with the vast majority having incomplete tetraplegia (40.6%). Other categories include incomplete paraplegia (18.7%), complete paraplegia (18.0%), and complete tetraplegia (11.6%) (NSCISC 2013). Even though these general categories exist, every person with a SCI has different nerve fibers damaged and a unique medical background that makes their SCI unlike any other. Because of this, individualized education is needed for patients with SCIs.

The Comprehensive Integrated Inpatient Rehabilitation Program, located at MedStar Good Samaritan Hospital (MGSH) in Baltimore, MD, and staffed by Johns Hopkins Physical Medicine and Rehabilitation faculty, has an interdisciplinary team that utilizes the expertise of physiatry (rehabilitation medicine), rehabilitation psychology, speech language pathology, occupational therapy, physical therapy, and nursing. This team is tasked with communicating the complex anatomy and physiology of SCIs and associated complications to patients. Knowing what to expect can help patients in recovery, both emotionally and physically. Acquiring information can help patients to maintain a feeling of personal control during the times they feel out of control (Cohen & Lazarus 1979). For patients with SCIs, physical and emotional recovery and living successfully after the injury are more likely when they know what to expect (Palmer, Kriegsman, and Palmer 2008). A better understanding of anatomy can help patients understand which symptoms are normal and which are cause for concern. Knowing more decreases their anxiety and helps improve their communication with healthcare providers and with their families and at-home care providers (Rutten et al. 2005).

Materials often used to help educate patients in rehabilitation facilities include text-heavy handouts with few images. The content of the handouts is relevant and helpful, but the images are often over-simplified and are commonly produced in black and white. These handouts are often
Introduction

discarded or poorly utilized. Information on paper is not interactive and engaging to patients, and with some patients with limited mobility, turning a page can be difficult or impossible. With the average American reading at an eighth grade level, non-text-based material is a more effective form of communication (Andrus and Roth 2002) Physical anatomical models are used in patient education. For examples, the speech language pathologists at MGSH have three midsagittal head and neck models which they use to explain upper respiratory and digestive anatomy (Fig. 1) and the occupational and physical therapists utilize a skeleton to show vertebral anatomy. Skeletons are great resources for bony landmarks, but are not representative of soft tissue damage. Medical models are useful resources, but they are expensive and inaccessible to patients after leaving the rehabilitation facility.

The rehabilitation center at MGSH has recently began utilizing touchscreen laptops to educate patients, but specialists struggle to find adequate digital visual materials. Online visual aids are either too information-dense and created with a specialist’s level of knowledge in mind, or over-simplified, providing few educational benefits. Interactive visual aids (other than navigable presentations) cannot

Figure 1. Three anatomical models used by the speech language pathologists at MedStar Good Samaritan Hospital to educate patients about upper respiratory and digestive anatomy.
be found. The creation of a collection of easily accessible interactive modules, animations, and images, will allow healthcare professionals to no longer depend on text-heavy handouts and patients to have access to educational materials at home.

**Objectives**

The goal of this thesis was to develop a cohesive, responsive website rich with interactive modules and animations, using an individualized, patient-centered approach. The website is divided into four sections, visible in the initial hierarchy of the main menu: General Anatomy, SCI Anatomy, Lifestyle Changes, and Complications. Due to the limited time of the project, the Lifestyle Changes section was not added to, but pages may be added later to any section. Within the website, visual communication assets include:

- Five animations (Spinal Cord Function, Spinal Cord Anatomy, Motor Neurons, Complete vs. Incomplete Injury, and Autonomic Dysreflexia)
- Five interactive modules (Dermatomes, Myotomes, Level of Injury, Syndromes, and Autonomic Dysreflexia)
- WebGL interactive model (Spinal Cord Anatomy)

A major objective in developing the UnderstandSCI.com website was to collaborate closely with medical professionals and patients. Input from all specialists on the interdisciplinary team was critical to obtain because each specialist works with patients at different times during the recovery period and, therefore, has a unique perspective on the patient’s informational needs. Whereas, patients know their individual struggles more intimately and can best describe what information is really important to them. The involvement of patients/consumers in the creation of health information has been shown to increase the quality of the final product (Bunge, Mühlhauser, and Steckelberg 2010).
Introduction

Audiences

The intended audiences for the website are patients (primary audience), their family and caregivers (secondary audience) and the rehabilitation team (tertiary audience). The specialists on the rehabilitation team can use the animations and interactive modules to explain SCIs to the patients during their recovery. The patients can visit the website independently and use it as a point of reference for conversations with care-providers. When patients return home, they will be able to use it to teach their family, at-home care providers, and friends, clarifying their own understanding at the same time. In addition, the rehabilitation team can display the website at conferences, and share the content with other rehabilitation facilities.
Materials & Methods

Needs Assessment

A needs assessment was performed by meeting with representative stakeholders from each specialty of the interdisciplinary SCI rehabilitation team and a patient with a SCI at MedStar Good Samaritan Hospital (MGSH). The different specialties that were included in the needs assessment were physiatry (rehabilitation medicine), rehabilitation psychology, speech language pathology, occupational therapy, physical therapy, and nursing. All but the physical and occupational therapists were met with individually.

Though the project had been introduced prior to the meeting, each meeting began with a verbal explanation of the project and its goals in plain language.

The following questions were then asked to each specialist:

- What topics, in general, do you spend a lot of time explaining to patients?
- What anatomy and/or physiology topics, in particular, do you spend a lot of time explaining to patients?
- Do patients often have a lot of questions on particular topics?
- Are there any concepts or more abstract ideas that patients have a hard time understanding about SCI?
- At what point during the rehabilitation process do patients seem to have the most questions related to anatomy and/or physiology topics? Beginning, middle, or end?
- Do you currently have visual assets that you use to help communicate with patients?
- If so, are they adequate? If not, what would you change about them?
- Do you find yourself drawing pictures to explain particular topics?
- Out of everything you feel needs new visual assets, what are some of the more important subjects?
- Are there any topics that you wish you had an interactive component to use while explaining them?
- Are there any topics that you wish you had an animation to play while explaining them?
The questions were altered for the meeting with the patient stakeholder:

- What topics, in general, did it take a long time for you to understand?
- What anatomy and/or physiology topics, in particular, did it take a long time for you to understand?
- Did you often have a lot of questions on particular topics?
- Are there any concepts or more abstract ideas that you had a hard time understanding about SCI?
- At what point during the rehabilitation process did you have the most questions related to anatomy and/or physiology? Beginning, middle, or end?
- What visual assets do you remember that the staff used to communicate anatomy and/or physiology with you?
- Were they adequate? If not, what would you change about them?
- Did you remember the staff drawing out topics for you?
- Out of everything you feel needs new visual assets, what are some of the more important subjects?
- Are there any topics that you wish you had an interactive component to use while they were explained?
- Are there any topics that you wish you had an animation to play while they were explained?

Feedback on potential content for inclusion in the website based on answers to these questions was used to guide the selection and hierarchy of topics. Potential topics of interest for animations, interactive media, and illustrations were compiled and organized into a flowchart (Fig. 2). Topics to bring to completion for the thesis were then chosen using the following criteria:

- The topic would be useful to multiple specialties in the interdisciplinary SCI rehabilitation team at MGSH.
- The topic was currently discussed in educational materials for SCI patients without or with insufficient visual aids.
- The topic was considered difficult to communicate verbally.
- The topic has a commonality in subject manner with multiple topics so that visual assets could be used at multiple points during rehabilitation.
Materials & Methods

Content Planning

Each topic to be brought to completion was assigned a format: interactive module, animation, or a combination of the two.

Interactive modules: Interactive modules were created with two-dimensional assets that were coded with JavaScript in Adobe Edge Animate®. Interactive modules were chosen for topics that involved connecting visual ideas that depicted interactions between multiple anatomical locations. This included an explanation of dermatomes, which involved creating the conceptual connection between spinal cord injury level and an area of sensation on the skin.

Animations: Animations were chosen for topics that could benefit from explanation through a linear visual narrative. This included topics such as autonomic dysreflexia, a complication of SCI with a complex etiology and the topic of spinal cord anatomy, which required the creation of three-dimensional assets to communicate the relationships of important anatomical structures.
Each topic was researched and reviewed prior to the creation of the narration and accompanying text. Information pertinent to patients was organized using the hierarchy developed during the needs assessment (Fig. 2). Animation scripts were developed into linear narratives that introduced medical terminology and important conceptual relationships early in the script before explaining more complex subject matter. If a complex term was needed to help the patient than it was defined. Text-based information included in animations was organized into concise lists. All text was analyzed under the Flesch-Kincaid Grade Level using the scoring system at Readability-Score.com and the text was reduced to an eighth grade reading level when possible. All narrations and copy were reviewed by medical professionals to confirm that the content was accurate and contained only relevant terminology.

For the interactive modules single storyboards showing the arrangement of objects on the screen were created. For the animations, separate storyboards were created for each scene. The narrations were used in the initial development of the storyboards and then it was confirmed that the stories were supported visually and that the content was told in the best way possible. The storyboards were reviewed by advisors, medical professionals, and a patient for pertinence, and understandability. Their feedback was implemented before continuing.
Visual Asset Development

Software

Storyboard and 2D Asset Creation:
- Adobe Illustrator® is a program used in the creation of vector graphics (Ruthruff 2012).
- Adobe Photoshop® is the leader in image editing and manipulation and allows for the production of raster graphics (Ruthruff 2012).

3D Asset Creation:
- OsiriX 64-bit from Pixmeo is a medical imaging viewer that allows for the exporting of surface renders from the medical datasets.
- 123D Catch from AutoDesk is a free application that uses photographs of objects to produce 3D meshes.
- Zbrush® from Pixologic™ is a digital sculpting program that allows for an organic manipulation of a dense mesh (Pixologic 2013).
- Cinema 4D™ Studio from Maxon is a high end 3D graphics program that allows for complex animation of models (“Cinema 4D Studio” 2014)

Audio Recording and Editing:
- Adobe Audition® is an audio editing program, used to manipulate and refine audio (Ruthruff 2012).

Final Product Creation:
- Adobe After Effects® is an advanced video compositing program allowing for the compilation of assets created in a range of other programs into a cohesive dynamic video (Ruthruff 2012).
- Adobe Edge Animate® is a new application that allows for web animation and interactivity free of browser dependent plugins by using HTML5, JavaScript, and CSS3 (“Adobe Edge Animate” 2014).

Website Development
- TextWrangler is a free text editor for web languages.
- Cyberduck is a free File Transfer Protocol (FTP) client that allows for the transfer of files from a computer to a website host.
3D Visual Asset Development

Each of the 3D visual assets: vertebral column, spinal cord, brain, and skin, was developed in a unique way due to the resources available for each structure.

Vertebral Column

Three anonymized OsiriX datasets were used to develop the 3D vertebral column model. The bony structures in each dataset were isolated (3D Viewer > 3D Surface Rendering). One surface was used at the default bone pixel value of 500. After rendering, the surfaces were exported from OsiriX as OBJs (Export 3D-SR > Export as Wavefront (.obj)).

The three OBJ files were imported into ZBrush® (Tool > Import) for optimization and compilation. The second and third OBJ files were imported by first inserting a new subtool (Tool > SubTool > Insert), selecting that new subtool, and then importing the OBJ (Tool > Import). Each subtool was first optimized by selecting unneeded areas and stray points with the lasso stroke and deleting them (Tool > Geometry > Modify Topology > Delete Hidden). Holes in the models were filled by deleting the polygons around the hole and closing the holes (Tool > Geometry > Modify Topology > Close Holes). The three subtools were then moved, scaled, and rotated to fit with each other. Once aligned, overlapping polygons were deleted. The three subtools were then merged into a single subtool (Tool > SubTool > Merge > MergeDown). Models merged to the same subtool maintain separate PolyFrames (meshes) and interact as separate objects when sculpted. This subtool was merged into a single PolyFrame by DynaMeshing (Tool > Geometry > Modify Topology > DynaMesh).

After the model was optimized, each vertebra was separated into its own subtool for individual manipulation. Separation was done by duplicating the subtool (Tool > SubTool > Duplicate), selecting the desired vertebra and deleting the rest of the new subtool’s polygons (Tool > Geometry > Modify Topology > Delete Hidden). The caps of the zygapophyses (vertebral joints) were recreated by filling the hole (Tool > Geometry > Modify Topology > Close Holes) and then sculpting them with brushes. Once the vertebra were separated, they were then further moved, rotated, and scaled, to give the classic “S” shape of the spine. This was done by following a template of a semitransparent image of a spine in Spotlight (Texture > Import, Add To Spotlight). Once the correct the anatomical shape of the vertebral column was established, the zygapophyses of each vertebra were revisited for further sculpting.
Materials & Methods

The intervertebral discs were created by adding and sculpting a Cylinder3D (Tool > SubTool > Insert > Cylinder3D) at the L5-sacral junction. This disc was then duplicated (Tool > SubTool > Duplicate) and modified to make the other intervertebral discs.

Spinal Cord

Soft tissue in MRI datasets is often difficult to isolate because of its similarity in intensity to surrounding structures. Because of this, the spinal cord was sculpted entirely in ZBrush®. The spinal cord was sculpted in the same ZBrush® project as the vertebral column so that the spinal canal and vertebral foramina could be used as guides. The armature for the spinal cord was made by ZSketch which allows the free development of meshes in 3D space (Pixologic 2013). First a ZSphere was added as a new subtool to the file (Tool > SubTool > Insert > ZSphere) and from that original ZSphere new ones were added and moved to create the general shape of the spinal cord (Fig. 3). Once the armature of the spinal cord was completed a “skin” was placed over it to create a mesh. The two categories of skins in ZBrush® are Adaptive Skin and Unified Skin (Tool > Adaptive Skin, Unified Skin). Adaptive Skin analyzes the ZSpheres and their interactions with each other to create a low resolution mesh and Unified Skin makes a mesh that is a merged unit of all of the ZSpheres (Pixologic 2013). In this case, using Adaptive Skin caused a program error and using Unified Skin would lose the details of the spinal nerves (Fig. 4). Under Adaptive Skin is an option to revert the skinning option to an older method used in ZBrush® 3 that allows for finer control of the resolution (Tool > Adaptive Skin > Classic Skinning) (Fig. 5) (Pixologic 2013). When a Classic Skin was used most of the detail of the ZSpheres was preserved (Fig. 6). Further sculpting was used to refine details.
Materials & Methods

Figure 3. ZSphere armature of spinal cord before skinned.

Figure 4. Unified Skin on ZSphere armature of spinal cord.
Brain

123D Catch was used for initial model development of the brain. Thirty-seven photographs of a plastinated specimen of half of a brain were taken in two concentric circles (Fig. 7). These photographs were uploaded to 123D Catch (www.123dapp.com/catch/ > Start a New Project > Select Photos > Process Capture) (Fig. 8). Once the photographs were processed into a 3D mesh the project was opened and downloaded as an OBJ (Open Selected Project > Menu > Export OBJ).

The OBJ file was then imported into Zbrush® (Tool > Import) and the background was removed (Tool > Geometry > Modify Topology > Delete Hidden). The overall shape of the brain was captured, but the intricacies of the gyri and sulci were lost (Fig. 9). The gyri and sulci were sculpted in ZBrush® using model references. Once the half of the brain was sculpted the subtool was duplicated (Tool > SubTool > Duplicated) and reflected on the z axis (Tool > Deformation > MirrorZ).
Figure 7. Sample of photographs used to produce 3D mesh in 123D Catch.

Figure 8. The model produced by 123D Catch.
Materials & Methods

Skin

The stock CT Melanix dataset in OsiriX was used to develop a surface render of the skin (3D Viewer > 3D Surface Rendering). The default skin pixel value of –500 was found to be the most accurate (Fig. 10). The body was scanned in two parts, the torso and the arms, both were exported as OBJs from OsiriX. Both OBJs were imported into ZBrush® and the body was moved into anatomical position using an image overlay in Spotlight. To move part of the body without disturbing the rest the subtool was duplicated (Tool > SubTool > Duplicate) and the duplicated subtool was rearranged until satisfactory. Then the overlapping polygons were deleted (Tool > Geometry > Modify Topology > Delete Hidden) and the two subtools were merged (Tool > SubTool > Merge > MergeDown). Merging two subtools is an irreversible action in ZBrush®, so incremental files were saved often during this process.

Compiling the Models

All of the models were brought into the same ZBrush® project where they were fitted together. Once in the correct position, the models on different subtools were DynaMeshed to a lower polygon count to be more easily manipulated in Cinema 4D™. In ZBrush® the models of the vertebral
Materials & Methods

Figure 10. 3D surface render of stock CT Melanix in OsiriX.

column, spinal cord, brain, and skin were merged into one subtool (SubTool > Merge > MergeDown) so that they could be exported as a single OBJ file, but their PolyFrames were keep separate. The file was imported into Cinema 4D™ (File > Merge) and each mesh became a separate object. The objects were renamed and grouped into nulls (Fig. 11). For simplified, well-defined images, Sketch and Toon was used (Render > Edit Render Settings > Effects > Sketch and Toon).

2D Visual Asset Development

A system of 2D asset production was developed to make the process efficient and give continuity to the images. All 2D assets originated as traditional line sketches on tracing paper. Once the line work was cleaned, sketches were scanned at black and white 300 dpi. Line work was traced in Illustrator® using a calligraphic brush set to a 15° angle, 50% roundness, and 2 points. Line thicknesses were later changed based on final artwork size and the importance of the line. Outlines were exported from Illustrator® as PNG files and imported into Photoshop®. In Photoshop® the ends of lines were cleaned and tapered when necessary. Lines along the bottom right side of the image were thickened to giving the image the impression of being lit from the upper left. Accents were added to the junctions of objects, a technique called “Snodgrassing” after Robert E. Snodgrass (GNSI Handbook).
Once the line work was complete, a tone layer was made under the line layer in Photoshop®. Separate layers were used for each color in an illustration. Dimension was added to the color layers with a soft brush. Once completed, a copy of each image was saved as a PNG.

The UnderstandSCI.com logo was produced using a different combination of Illustrator® and Photoshop®. A PNG render of the vertebral column in Cinema 4D™ was taken into Photoshop® and made into a flat silhouette. A copy of the image was saved as a PNG in Photoshop® and imported into Illustrator® where the text was added (Fig. 12).

A favicon is a small image (16 by 16 pixels) that is seen next to the title of the page in a tab of a browser (Fig. 13). It reinforces the branding of a website and gives a more polished feel. Because of the pixel size limit, a favicon must be very simple. For the favicon of UnderstandSCI.com the image of the vertebral column in the logo was condensed to a 16 by 16 pixel canvas in Photoshop® and exported as a JPEG.
Interactive Module & Animation Development

Audio Recording & Editing

The narrations were recorded before animating so that the animations could be timed to the narrations. Audio was recorded in Adobe Audition® at 48000Hz and 24bit generating a WAV file. A MXL® 2001 Large Diaphragm Condenser Mic with David Royer U67 modification on a On-Stage Stands® DS7200B adjustable desktop stand with a On-Stage Stands® ASFSS6GB dual-screen pop blocker using an Apogee One single channel USB audio interface was used to record the audio. A gap was given at the beginning of each narration to assist in the removal of ambient noise in audio editing. The narrations were spoken smoothly and slowly. Words that would appear on screen were emphasized. Breaks were taken between each scene for better control of timing between scenes in audio editing.

The audio was edited in Audition®. A noise print was captured by selected a section of the audio with only ambient noise (Effects > Noise Reduction/Restoration > Capture Noise Print) (Fig. 14). The ambient noise was removed from the audio file using the default settings (Effects→Noise Reduction/Restoration→Noise Reduction (process)) (Fig. 15).

![Image](image.png)

Figure 14. The audio as it initially appeared inside Audition with a section selected that contains only ambient
Interactive Module Development

All interactive modules were made at the original resolution of 1600 by 900 pixels. The Stage was set to Responsive Scaling by Width. The background was left blank and all text was at least 24 points.

Interactive SVG files were used in Adobe Edge Animate® when a rollover of adjacent non-rectangle or circular shaped was needed. The current version of Edge Animate® supports the transparency of PNGs, but the active area of the image, as it relates to rollover and on click functions, is still rectangular. SVGs were created in Adobe Illustrator® by File > Save As and selecting “SVG” under format (Fig. 16). Under the SVG Interactivity window in Illustrator® one path was given a JavaScript “notify(this,”select”);” function on

Figure 15. The audio in Audition after Noise Reduction was used to remove the ambient noise.

Figure 16. “Save As” window in Illustrator with SVG format selected.
an “onclick” event (Fig. 17). This code only needed to be applied to one path and other paths in the same group would also be seen in Edge Animate®. To see objects as a single unit in Edge®, they must be part of a compound path in Illustrator®. Every path in a compound path must have the same fill and stroke. For example, a line with stroke and no fill and a rectangle with fill and no stroke cannot be part of the same path. Also, two compound paths cannot be compiled together into a compound path.

In Edge Animate® the interactive SVG components were called upon in the “creationComplete” Open Actions of the Stage (Stage > Open actions + creationComplete). A “yepnope” function loaded the online EdgeCommons JavaScript (Fig. 18). Then the SVG file was uploaded (Fig. 19) and all selected objects were set to 100% opacity (Fig. 20).

Figure 17. SVG Interactivity window in Illustrator with JavaScript code used to make path visible in Edge Animate.

Figure 18. “yepnope” statement in “creationComplete” of Stage in Edge Animate to call Edge Commons JavaScript used for SVG Interactivity.

Figure 19. Statement in “creationComplete” of Stage in Edge Animate to call upon the specific SVG file.

Figure 20. Statement in “creationComplete” of Stage in Edge Animate to change the opacity of selected object.
Interactive 3D Model Development (WebGL)

WebGL allows for plugin-free interactivity with 3D models in the four major browsers: Safari, Chrome, Firefox, and Opera (“OpenGL ES 2.0 for the Web” 2014). Three.js is a library of resources that makes WebGL more straightforward (“Creating a Scene”). The Three.js library was downloaded from GitHub at github.com/mrdoob/three.js. The most stable object file type for Three.js is JSON, but Cinema 4D™ does not export JSONs (Johnston 2013). Three.js also works with the much more common file type, OBJ. An example of Three.js being used to produce a WebGL with an OBJ was found at radiatedpixel.com/wordpress/2013/03/27/webgl-3d-model-viewer-using-three-js/. In the comments of the tutorial the author provided a ZIP file with all of the files needed to produce the WebGL. The files were used as a template to develop a WebGL model. By default a WebGL model is centered in the browser. By setting the position of the canvas to “fixed” and adjusting the padding the model was moved to the right side of the browser (Fig. 21).

Animation Development

All animations were developed with a final resolution of 1920 by 1080 pixels.

3D Animation Development

3D dimensional portions of the animations were developed in Cinema 4D™ and exported out as PNG sequences at 4050 by 5400 pixels. This resolution is five times the resolution of half of 1920 by 1080 (960 by 1080). The visual assets of the animation are consistently on the left half of the animations. This is why the final resolution of 960 by 1080 pixels was chosen. This resolution was multiplied times five so that straight zooming could take place in After Effects® and not Cinema 4D™.

When possible, objects in the scene rotated to allow the viewer to appreciate their three dimensional relationships. Four seconds (120 frames) were allocated to each rotation so that they were not too fast as to be disorienting.
The spinal cord was cut using a cylinder in a Boole to extract the unwanted parts of the spinal cord. A Boole was added to the scene (Create > Modeling > Boole) and the two objects were put into the Boole as children, with the one being subtracted from on top. When a Boole is used the subtracted edge of the final product will have the material of the now invisible object that is subtracting. To accomplish the same look on the 3D cross section as the 2D cross section the 2D image was brought into a material in Cinema 4D™ (Material Editor > Color > Texture > Load Image). This material was then put into a texture tag so that its scale and orientation could be manipulated (Tags > CINEMA 4D Tags > Texture > Tag > drag the material to the Material box). The Offset U, Offset V, Length U, and Length V settings were manipulated until the image was the correct size and centered on the cut edge.

**2D Animation Development**

Asset compositing and 2D animation took place in After Effects®. The left half of the screen was typically dedicated to imagery and the right half dedicated to the word story. Many Animation Presets (Animation > Browse Presets) were used to make the text more dynamic. Fade Up Words was used for a majority of the text to fade one word at a time while maintaining a large number of words in the same object. Timing the words or lines to the narration with the Fade Up Words preset was accomplished by key framing the end of the word or line and copying and pasting that key frame to when the next word or line was said. Magnify was used to emphasize the letters of words that produced the acronyms used, such as magnifying A and D in Autonomic Dysreflexia because it is commonly referred to as AD. Scale Up was used to similar effect when an entire word that was already on screen required reemphasizes.

There is currently no simple way to convert regular text to bold text in After Effects®, but a smooth transition can be achieved by path manipulation. First the regular style text was duplicated and the duplicated layer was converted to bold. Then the outlines of both the regular and bold text were made (Layer > Create Shapes from Text). Within the new layer that was made, there is a Content section that has each letter in it and within each letter is the letter again with a Path that can be key framed. If the letter had an opening such as “a” or “o” there was two Paths. All of the Paths for the letters in the regular text outlines were key framed. The paths from the bold text were copied individually to
the layer of the regular text at a key frame one second later. The regular text is converted to the bold text over that second, but the path movement is not always done efficiently (Fig. 22). This was fixed by confirming the same point on the regular and bold paths was the first vertex (Layer > Mask and Shape Path > Set First Vertex).

To animate text along a path, first the text object was created, and then, with the text object selected, a path was drawn. The mask made from the path was selected as the path of the text (Text > Path Options > Path > Mask 1).

When lines were to appear on screen, the Write-on Effect was often used so that they would grow on screen. Under the object in the Effects menu, a Write-on tab would appear. To have the object grow on, the Paint Style was changed to Reveal Original Image and the Brush Position was key framed. When objects appeared to grow on screen, a Mask with a feathered edge and the Path key framed was used.

In the Motor Neurons animation the bladder is animated contracting and relaxing. The transition was accomplished smoothly with seven separate images produced by the Liquify filter in Photoshop® (Filter > Liquify). A yellow shape object was drawn with the pen tool in After Effects® and point animated to depict urine filling the bladder. An elliptical mask with a strong feather was added to the yellow object to fade the edges out, avoiding the need for precise point animation. The movement of the bladder was animated in its own composition so it could be easily repeat in a new timeline.

**Website Development**

A content management system (CMS) was implemented for the website because of the flexibility and ease of use of this type of framework compared to a static HTML website. Wordpress is the most commonly used CMS (“CMS Usage Statistics” 2014). Wordpress, as well as some other CMSs, is PHP based and uses a MySQL database (Clark 2010).

There are many Wordpress templates available that already have a website theme established and allow the user to easily change aspects such as colors, fonts, and content to individualized the website. ThemeForest.com has a large variety of Wordpress themes and reviews them to verify that all work well and are easy to use (“How Does ThemeForest Work?” 2014).
InMotion Hosting was used because it is reliable and inexpensive. When InMotion Hosting was purchased, the domain UnderstandSCI.com came with the new account at no additional cost.

Once the Wordpress template, hosting, and domain name were purchased, Wordpress was installed onto the host server. InMotion Hosting uses the cPanel, or control panel, to control aspects of domains. Through the cPanel, Wordpress was easily installed to the domain using software called Softaculous (cPanel > Software/Services > Softaculous > Wordpress > Install). Once Wordpress was installed to the domain, the Wordpress interface was accessed at UnderstandSCI.com/wp-admin/.

The David & Goliath template was then installed to the website (Appearance > Themes > Add New Theme > Upload > Choose File > browse for ZIP > Install Now). After the template was installed, it was activated under the Theme tab.

After the template was activated on UnderstandSCI.com the plugin Private Only was downloaded and activated (Plugins > Add New). Private Only redirects user to a login page, that is customizable (Plugins > Installed Plugins > Private Only > Private Only Custom Login) and turning it off only requires that the plugin be deactivated.

The general settings and organization of the template were customized to give the website its own unique identity separate from the template. The Logo and Favicon were added under the General Settings (VamTam > General Settings > General Settings). In the Layout settings a top menu with a centered logo and a search function was chosen because of its straightforward design (VamTam > Layout > Header) (Fig. 23). In the body layout, breadcrumbs were enabled as another form of navigation and a body with no sidebar was chosen because there was not need for a sidebar (VamTam > Layout > Body). Five spaces for widgets in the footer were chosen for a tag line, three affiliations and a translation plugin (Fig. 24 & 25). The translation plugin Transposh Wordpress Translation was used because it allows for the automatic translation to many languages with an easy to use interface. Under Widgets (Appearance > Widgets) the five spaces of the footer were filled in (Fig. 26). In the Global Colors section, the top five accent colors were changed to the main two colors of the website (VamTam > Styles > Global Colors and Background > Global Colors) to give continuity with the visual assets (Fig. 27). In General Typography, Header, Body, and Footer the text was changed to Trebuchet MS in the same dark gray (Fig. 28).
Materials & Methods

Blank pages of each page were made (Pages > Add New) for the hierarchical organization of the main menu and to copy static HTML pages for the implementation of interactive modules. All of these pages were added to the Menu Structure and organized (Appearance > Menus > Menu Structure) (Fig. 29). Every heading in the menu is clickable, if it is not a terminal page, then it is a portfolio page showing the options for terminal pages under its section (Fig. 30). These portfolio pages were made by adding a portfolio post for every terminal page (Portfolios > Add New). Under the VamTam Portfolio Format the Link option was chosen so that these portfolio posts linked to the pages desired (Fig. 31). The featured image of these portfolio posts was a screen shot of the page. Under the page that was suppose to be a portfolio viewer a Portfolio was added using the Vamtam Drag & Drop Editor (Fig. 32). Within the portfolio, the posts desired were selected (Fig. 33).

Edge Animate® released a new version in the beginning of 2014 that allows for integrated responsive design as well as embedded audio, but during the completion of the project, the Edge® compression file format, OAM, would not recognize image or audio files. The Wordpress plugin Edge Suite can be used
Figure 24. Footer section in the VamTam Layout tab of the Wordpress Dashboard.

Figure 25. Final layout of the website footer with five widgets.
Materials & Methods

Figure 26. The widgets used in the five footer widget areas.

Figure 27. Global Colors section in the VamTam Styles tab of the Wordpress Dashboard.
Materials & Methods

28

to directly implement Edge Animate® interactive modules into a Wordpress template using the OAM file. Due to audio and images not being compressed into the OAM file, interactive modules developed in Edge Animate® were manually placed into static HTML pages that were linked to the Wordpress website. Static HTML pages were developed by going to the blank page developed in Wordpress and copying the code (Developer > View Source > right click > Save As). In TextWrangler the HTML page that Edge Animate® develops was opened along side the HTML page from Wordpress. The Edge Animate® HTML page is very short with a part in the header defining parameters and linking it to the initial JavaScript and a part in the body directing the Stage placement (Fig. 34). The header parameters from Edge Animate® were copied into the end of the header in the Wordpress HTML page (Fig. 35). The body parameters were copied into the div class “page-content no-image” (Fig. 36). This HTML

Figure 28. General Typography section in the VamTam Styles tab of the Wordpress Dashboard.
Menu Structure

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration options.

- General anatomy
- Spinal cord
- Spinal cord function
- Spinal cord anatomy
- Nerves
- Motor neurons
- Dermatomes & myotomes
  - Dermatomes
  - Myotomes
- SCI anatomy
  - Level of injury
  - Completeness
  - Complete vs. incomplete
  - Syndromes
- Lifestyle changes
- Complications
  - Autonomic dysreflexia
- Return to discharge page

Figure 29. Edited Menus section in the Appearance Menus tab of the Wordpress Dashboard.
Figure 30. SCI anatomy page with an option to choose one of the three terminal pages hierarchically lower.

Figure 31. Link selected in the VamTam Portfolio Format of the portfolio post.

Figure 32. The Portfolio option selected in the VamTam Drag & Drop Editor of the page.
file as well as the JavaScript, image, and audio files were added to the /public_html folder of the website using Cyberduck. These pages could then be found at UnderstandSCI.com/name-of-file.html. These pages were linked to the website by adding their url into the main menu (Appearance > Menus > Edit Menus > Links > Add to Menu) (Fig. 37).

The WebGL interactive 3D model was also added to the website by editing a static HTML page. This was done because WebGL also depends on external JavaScript files and linking to them directly within the website content is the most direct way to implement them.

Videos were uploaded to both Vimeo and YouTube. Vimeo was used for the videos to be embedded into Understand SCI.com because of its professional appearing player. Videos were also uploaded to YouTube because YouTube has the most amount of users of any video sharing website (Tan 2013). All videos are accessible from searching for them on Vimeo or Youtube and on the UnderstandSCI.com website.

```html
<!DOCTYPE html>
<html>
<head>
<meta http-equiv="Content-Type" content="text/html; charset=utf-8"/>
<meta http-equiv="X-UA-Compatible" content="IE=Edge"/>
<title>Level of injury</title>
<!--Adobe Edge Runtime-->
<script type="text/javascript" charset="utf-8" src="Level_edgePreload.js"></script>
<script>
.edgeLoad-EDGE-1025675546 { visibility: hidden; }
</script>
<!--Adobe Edge Runtime End-->
</head>
<body style="margin:0;padding:0;">
<div id="Stage" class="EDGE-1025675546">
</div>
</body>
</html>
```

Figure 34. HTML page produced by Edge Animate that initiates the interactive module.
Materials & Methods

Figure 35. Edge Animate header HTML pasted into the Wordpress HTML header.

Figure 36. Edge Animate body HTML pasted into the Wordpress HTML body in the "page-content" div.

Figure 37. Pages window in the Menus section in the Appearance Menus tab of the Wordpress Dashboard.
Results

Utilizing a Wordpress template allows the website to be responsive to the size of the screen it is viewed on (Fig. 38 A–D). The homepage of the website contains an animation comprised of all the animations within the website, for users that are not able to easily navigate between pages. The website was given many forms of navigation, allowing users to navigate in their desired fashion: main menu, search bar and breadcrumbs. At the top of every page of the website is the same main menu, giving a consistency to the organization. Each section in the menu goes to a page, even if the section was simply there for categorical reasons. If the page is not a terminal page with content, it is a portfolio page with links to all of the terminal pages beneath it (Fig. 29). This prevents users from being confused when clicking on a section of the menu and having it not go to any page. The menu contains a search bar in which the user can enter any keyword and all pages on which that word is used will appear in the search results. Every page except for the homepage has breadcrumbs at the top of the page between the menu and the title (Fig. 39). The breadcrumbs are a static representation of where that specific page is located in the hierarchy of the website.
Figure 38 A–D. How the homepage appears on different devices. A. Computer monitor. B. Full size iPad. C. Android Galaxy S4. D. iPhone 5.
There are four main sections: General anatomy, SCI anatomy, Lifestyle changes, and Complications. No components of the Lifestyle changes section were completed as part of this thesis because most aspects of this section could be easily communicated through photographs and video clips, as opposed to illustrations and animations.

The General anatomy section covers the spinal cord, nerves, and dermatomes and myotomes. Under the spinal cord section there are two terminal pages: Spinal cord function (Fig. 39) and Spinal cord anatomy (Fig. 40). Spinal cord function consists of a short 2D animation with the narration to the side of it. The animation goes over the general function of the spinal cord, carrying messages between the brain and the body, comparing it to a telephone cable, and the two directions information travels.

Spinal cord anatomy contains a 3D animation and a WebGL interactive. The animation explains the important anatomical component of the spinal cord and its surrounding structures: the brain, vertebral column, and intervertebral discs. These structures are often referred to by medical professionals and this animation gives the patients a basic understanding of their relationships to each other and why they are important. The WebGL interactive is a model of the vertebral column that patients can use to understand its 3D structure when not in a clinical environment with a physical model available.
Under the Nerves section, the Motor neurons page (Fig. 41) was brought to completion for this thesis. It consists of a 2D animation and the narration of the animation beside it. In the animation, the division of motor neurons into upper motor neurons and lower motor neurons is made clear and how injuries to them have very different outcomes.
The Dermatome and myotome section has two terminal pages, Dermatomes (Fig. 42) and Myotomes (Fig. 43). Both of these pages are interactive modules. The Dermatome interactive module allows the user to rollover the spinal cord, anterior body, or posterior body to see how the dermatome wraps around the body and the pair of spinal nerves with which it correlates. If a dermatome is clicked, a description of the area that the physician tests for that particular dermatome appears in the box in the upper right corner of the screen. The Myotome interactive module has the spinal cord on the left as a navigational tool, with the ten myotomes that are tested labeled, and the movements which are tested on the right. The spinal cord, labels, and arrows can be rolled over to highlight their corresponding myotomes and pairs of spinal nerves. This shows the users the correlation between a pair of spinal nerves and an action.

Figure 42. Screenshot of Dermatomes page in General anatomy.
The SCI anatomy section has two subsections: Level of injury and Completeness. Level of injury (Fig. 44) is a terminal page with an interactive module that combines the myotome and dermatome interactive modules. The user is able to rollover a level on the spinal cord and all of the dermatomes and myotomes possibly affected in someone with an injury at the level are highlighted. This is for users to learn more about specific injuries, personalizing the information.

Completeness has two sections Complete vs. incomplete (Fig. 45) and Syndromes (Fig. 46). The Complete vs. incomplete page has a 2D animation and the narration of that animation. The 2D animation compares complete SCIs to incomplete SCIs using the metaphor of a telephone cable that is completely cut verses a frayed telephone cable. The animation also discusses how spinal cord symptoms may change as swelling and bruising go down after an injury.
Figure 44. Screenshot of Level of injury page in SCI anatomy.

Figure 45. Screenshot of Complete vs. incomplete page in SCI anatomy.
The Syndromes page has two interactive modules: defining the five different syndromes on the left and labeling important spinal tracts on the right. When one of the syndromes is selected the cross sectional area and the levels of the spinal cord that are possibly affected are highlighted (Fig. 47). In the information box a description, list of symptoms, and recovery information can be toggled through for each syndrome. For the conus medullaris and cauda equina syndromes, no area is highlighted on the cross section because they are not in the spinal cord.

In the Complications section, the page about Autonomic dysreflexia (Fig. 48) was completed. It has an animation describing the complex cause of the condition and detailing the symptoms. The text on the right lists the possible causes for users to quickly reference if they are currently suffering from autonomic dysreflexia. An interactive module can be activated in the lower right that offers information on ways to help prevent autonomic dysreflexia (Fig. 49).
Figure 47. Screenshot of Syndromes page in SCI anatomy with the Brown-Sequard syndrome and Dorsal columns highlighted.

Figure 48. Screenshot of Autonomic dysreflexia page in SCI anatomy.
Figure 49. Screenshot of Autonomic dysreflexia page in SCI anatomy with the precautions interactive module activated.

Access to Assets Resulting from this Thesis

Access to the website resulting from this thesis can be viewed as www.understandsci.com, or by contacting the author at katelyn.mcd@gmail.com. The author may also be reached through the Department of Art as Applied to Medicine via the website www.hopkinsmedicine.org/medart/.
Discussion

This thesis project offers a source of educational materials for patients with spinal cord injuries (SCIs), to assist the rehabilitation staff at MedStar Good Samaritan Hospital (MGSH). Though MGSH has recently implemented state-of-the-art touchscreen hardware technology, they have not been able to find adequate educational visuals to show and effectively educate their patients. Currently, most educational materials for patients with SCIs in the rehabilitation setting are in the form of paper handouts, often with limited, simple, and/or poorly designed illustrations. Some digital resources are used and there are websites describing aspects of SCIs, but these websites are often text heavy and none are interactive. It was thought that an interactive website would be ideal, so patients could have a source of interactive educational material that could be utilized both during and after rehabilitation. UnderstandSCI.com gives these patients and their families a place to go to learn about SCIs via straightforward, interactive modules and animations.

The media used for each topic was carefully chosen to utilize the technology available in the most effective manner. Interactive modules were used when possible, because they are absent from the current resources for patients and two-dimensional interactive modules are generally considered a more user-friendly format than three-dimensional interactive modules. If a two-dimensional interactive module required an explanation, an animation made in Adobe Edge Animate® was embedded. When an interactive was not possible to explain the process or structure, an animation was used. For animations, the organization of the narration was used to facilitate comprehension for viewers with no prior knowledge on the subject and/or low health literacy. The overall continuity and simplicity of the language, color, font, and artwork across the animations and interactive modules allows the users to focus on the educational benefits of the material. Breaking the animations into short informational segments allows the viewer to not be overwhelmed, but compiling all the animations into one location on the homepage allows for users with limited mobility to have access to all of the resources. Persons with SCIs have a large range of severity of injury and the educational material should account for those that cannot turn a page or pull down a menu. Digital educational solutions would seem to be better for individuals with high injuries than printed material with which they are only able to view one page or spread at a time.
Because of the large variety in monitor sizes and the growing use of mobile devices, such as smartphones and tablets, the website could reach a larger audience if it was responsive. Responsiveness can be implemented into a basic HTML website, but it is more efficient to utilize an already well-designed, responsive template within a Content Management System such as Wordpress.

The Wordpress template used had to be simple overall, with a minimal number of design elements. The main audience is older and may have limited control of movement, so simplicity was important so as not to distract from the educational elements of the website. A template responsive to the dimensions of the browser window was also important. Responsive design allows for the website to adapt to the variety of sizes of monitors and devices. When users are confused by the navigation or want to quickly find information they will often go straight to a search bar. Search bars can be added to Wordpress websites with a plugin, but those often do not work as well and do not look as cohesive as built in search functions so a well functioning search function was another important criteria of the Wordpress template. Tertiary menus were needed for the hierarchical organization of the website which had been previously determined (Fig. 2). Tertiary menus can also often be added later to the template, but this can be a hassle and may never work properly. Thus, built in tertiary menus were an important aspect to look for in the templates. Many more well-developed Wordpress templates have a variety of options in the theme and this allows the theme to be manipulated into the desired outcome more effectively. Therefore, having an overall, well-developed template with many options was critical.

Using these criteria, two Wordpress templates were chosen and discussed, Nemo and David & Goliath. Nemo has an overall simple and playful design that would have worked well with the feel of the website (Fig. 50). The multicolumn menu allows for a large number of subjects to be added to the website without the menu becoming too long for the height of the browser (Fig. 51). However, the menu does not have any built in tertiary menu and has a box that follows the cursor on the menu, an unnecessary flashy design element. Nemo has a built in search function, but to use the search function, the user must first click an icon and the search bar flashes out (Fig. 52 & 53), again, an unnecessary flashy design element. David & Goliath is a more professional business-like design (Fig. 54). Though the menus are designed as only a single column, they already have built-in, clean,
Figure 50. Homepage of the *Nemo* Wordpress template.

Figure 51. Two-column menu of the *Nemo* Wordpress template.
tertiary menus (Fig. 55). The search bar is always visible and plainly labeled “Search” (Fig. 56). David & Goliath is also a large template with many options for every part of the website. David & Goliath was chosen to be the Wordpress template because of its ease of use and many options. To buy the template a ThemeForest account was made and under the Downloads tab of the account, the ZIP file of the template was downloaded.
A domain name is the url that is typed into the address bar of a browser. The most common suffix of a domain name is .com. A .com suffix was used to have the domain name more memorable. Using Namecheap.com different combinations of educational and visual words with SCI were found. A domain name should be short, simple, and easy to remember, following those criteria UnderstandSCI.com was chosen.

**Future of UnderstandSCI.com**

The project offers rehabilitation specialists a much-needed means of conveying important information to their patients. The website will be a linked on the MGSH discharge website for their staff and patients to easily reference. Consistent access to the same dynamic learning tools allows patients to visit these animations and interactive modules as often as they desire to reinforce content.

Because UnderstandSCI.com is a Wordpress site it can easily be added to and changed without
Discussion

the knowledge of any coding language. The visual assets produced can be used to cover a variety of different topics. Such as, with the neuron illustration that was already produced for the motor neuron animation, an interactive module could easily be developed to explain the different parts of a neuron. Because a large amount of the anatomy was sculpted into 3D models these models could be utilized for not only 3D solutions but also 2D solutions in which different angles of a structure were required. Though implementation of the interactive modules had to be done through direct code manipulation, when Edge Animate’s malfunction that does not compress external files into OAMs is fixed, the interactive modules can be uploaded directly from Edge to Wordpress via the Edge Suite plugin. WebGL is a growing technology and the vertebral column model can have the other 3D models added to it and given the capability to scale the object.

The website as a whole could be used as a model for educational websites for other medical conditions. Material could be reused and individualized to the other conditions, lifestyle changes related to mobility would be similar for SCI patients and stroke patients.

Patient communication aids allow patients to be participants in their recovery instead of just observers. A knowledgeable patient will be better able to communicate with their medical team and to know when symptoms require action to be taken. By enriching patients’ educational experience, this project not only aims to improve patients’ quality of life, but also decrease avoidable complications (French and Larrabee 1999).
Appendices

Appendix A: Narrations

Spinal cord function

Your spinal cord uses your spinal nerves to carry messages between your brain and your body.

The spinal cord is like a telephone cable, a bundle of telephone lines, connecting your brain to your body.

Messages travel through your spinal cord in two directions. Sensory messages travel from your body to your brain to give your brain information about sensations, such as touch, temperature, pain, and joint position. Motor messages travel from your brain to your body to control movement and body functions. Spinal cord injuries can affect the sensory nerves, motor nerves, or both.

Spinal cord anatomy

Your central nervous system is made up of your brain and spinal cord.

Your spinal cord is a bundle of nerve cell bodies and fibers. It is soft and pliable, but strong.

Your spinal cord is about half an inch wide, a little smaller than a dime.

It is about 17 inches long and extends from your brain to your lower back. The portion of the spinal cord just above your waist is called the conus medullaris. Below the conus medullaris are nerve roots called the cauda equina.

Your backbone is made of 33 bones called vertebrae. Each of your vertebrae has an arch and… stacking them forms a tunnel. This tunnel is called the spinal canal and your spinal cord runs through it. The vertebral column gives support and flexibility to your body and protects your spinal cord.

Between each of your vertebrae are tough, fibrous vertebral discs, acting like cushions. Your vertebral discs stop your vertebrae from rubbing against each other and protect your spinal nerves where they exit between vertebrae.

Spinal nerves branch from your spinal cord. There are 31 pairs of spinal nerves and they are named by the vertebrae they pass through. There are 5 sections of the vertebral column and spinal cord: cervical, thoracic, lumbar, sacral, and coccyx. Each vertebrae and pair of spinal nerves is given a letter representing its section, C, T, L, S, and Co, and a number.

In your neck there are 7 cervical vertebrae and 8 pairs of cervical spinal nerves. Your cervical spinal
nerves are numbered by the vertebra below them, except C8, which exits below C7 and above T1.

The rest of your spinal nerves are numbered by the vertebra above them. Your cervical spinal nerves control your neck, arms, hands, and your main breathing muscle, the diaphragm.

In your chest there are 12 thoracic vertebrae and 12 pairs of thoracic spinal nerves. Thoracic vertebrae each have a pair of ribs attached. Your thoracic spinal nerves control your trunk and upper abdomen, helping you sit, stand, and breathe.

In your abdomen there are 5 lumbar vertebrae and 5 pairs of lumbar spinal nerves. Your lumbar spinal nerves control your abdomen and upper legs.

In your pelvis there are 5 fused sacral vertebrae, called the sacrum, and 5 pairs of sacral spinal nerves. Your sacral spinal nerves control your lower legs, bowel, bladder and sexual organs.

In your tailbone there are 4 fused coccyx vertebrae and 1 pair of coccyx spinal nerves. Your coccyx spinal nerves provide sensation to your coccyx.

**Motor Neurons**

Neurons are the individual cells that make up nerves.

Most motor neurons in your spinal cord are upper motor neurons. Lower motor neurons start in the front of your gray matter and leave your spinal cord in your spinal nerves.

Because your cauda equina is made of spinal nerves it has lower motor neurons.

Injuries to your spinal cord typically have upper motor neuron injuries or lesions. Injuries to your conus medullaris, the end of your spinal cord, can have a mix of upper and lower motor neuron lesions. Injuries to your cauda equina have lower motor neuron lesions.

Your upper motor neurons control your lower motor neurons. Your lower motor neurons control the reflexes of your bladder, bowel, sexual organs, and muscles. Whether your injury has damaged upper motor neurons, lower motor neurons, or both means a lot in the function of your bladder, bowel, and sexual organs.

For example, in an upper motor neuron lesion your bladder will likely have reflex contractions.

In a lower motor neuron lesion your bladder will have no tone, and will probably not be able to contract. Knowing what kind of lesion you have allows you to work with your doctor and find the best lifestyle changes for yourself.
Complete vs. Incomplete

Spinal cord injuries, or SCIs can be incomplete or complete.

A complete SCI is like cutting the telephone line. Phone calls are completely blocked. The terms complete and incomplete describe the function of your spinal cord, not the physical damage to it. If a cable only appears to be partially damaged, but is not working at all, it is described as not working.

An incomplete SCI is like fraying the telephone line. Phone calls are unpredictable and have static. The amount and type of messages that can go between your brain and your body will depend on how many nerves are damaged. Each incomplete SCI is unique because different nerve fibers are damaged in the person’s spinal cord. Some people with an incomplete SCI may have a lot of feeling but little movement and others may have a lot of movement but little feeling.

After a spinal cord injury the spinal cord may be bruised or swollen. When the swelling of the spinal cord goes down, the nerves may begin to work again. The motor and sensory level of the injury may change as healing progresses. Depending on the person’s SCI, this recovery may be rapid or slow. It is impossible to accurately predict how much of a person’s sensory or motor function will return and at what speed.

Autonomic Dysreflexia

Autonomic dysreflexia (AD), or hyperreflexia, is your body over reacting to something happening to it below the level of your spinal cord injury or SCI.

AD is most common in high injuries, T6 or above. It is rare and less severe, but it can happen to people with SCI’s as low as T10. AD is more common and severe in people with complete SCI’s than those with incomplete SCI’s. AD can be life threatening and is considered a medical emergency.

Your autonomic nervous system is the part of your nervous system that controls parts of your body automatically without you thinking about them, such as heart rate, circulation, breathing, digestion, or sweating.

Your autonomic nervous system is grouped into parasympathetic and sympathetic. Your parasympathetic nervous system responds in rest and digest situations.

It makes you salivate, your digestion increase, and your skin’s blood vessels widen.
Your sympathetic nervous system responds in fight or flight situations, stressful situations.

It makes your heart beat faster, your skin’s blood vessels narrow, and your pupils widen so you can see better.

When something irritates your body below your SCI, signals are sent to your spinal cord to trigger a sympathetic (fight or flight) response. This response narrows your skin’s blood vessels and raises your blood pressure. Your blood pressure will continue to rise until what is irritating your body is stopped, this is why AD is so dangerous. When the irritant’s signal travels up your spinal cord to tell your brain what it wrong, the signal is blocked by your SCI. These signals keep raising your blood pressure, but your brain has no idea why.

Sensors near your heart sense your raised blood pressure and tell your brain that there is a sympathetic response. Your brain does not know why there is a sympathetic response so it sends a parasympathetic (rest and digest) response down your spinal cord to counteract the sympathetic response. The parasympathetic signal from your brain is blocked by your SCI. This means above the level of your SCI your body shows parasympathetic symptoms and below the level of your SCI your body shows sympathetic symptoms.

The most common symptom is a sudden pounding headache caused by your raised blood pressure. The strong parasympathetic (rest and digest) response causes you to have a slow pulse, stuffed nose, small pupils, and, above the level of your SCI, flushed, splotchy and sweaty skin. The small pupils and high blood pressure can cause vision changes such as blurring, seeing spots, and narrowing of vision. Below the level of your SCI the strong sympathetic (fight or flight) response causes your skin to be pale, cool, and covered in goose bumps. Because of the discomfort you may feel nauseous and restless. If left untreated autonomic dysreflexia may lead to seizures, stroke, or death.

AD requires quick action. It is important to lower your blood pressure, so if possible move into a more upright position and dangle your legs. Remove or loosen any tight clothing or accessories that could be the cause. If possible have someone check your blood pressure to see if it is lowering. Remember that the resting blood pressure for people with SCI’s is lower than it was before the SCI. It is important to take your blood pressure regularly so you know your resting blood pressure. The most important step when you have AD is to find the cause and relieve it.
Bladder and bowel problems are the most common causes of AD. Skin problems, usually pressure sores, can also cause AD so it is important to regularly check your skin.

If you are unable to find the problem or relieve it within 5–10 minutes, call 911 for immediate medical assistance. Become familiar with the symptoms, treatments, and causes and make sure those close to you are aware as well. Since not all doctors are familiar with AD it is useful to carry a card about AD in your wallet.
Appendix B: Storyboards (Spinal Cord Function 1–4)

**Narration:** Messages travel through your spinal cord in two directions. Sensory messages travel from your body to your brain to give you information about sensations, such as touch, temperature, pain, and joint position. Motor messages travel from your brain to your body to direct movement, body functions, and sensation.

**Visual:** The spinal cord is like a telephone cable bundle. Messages travel through the spinal cord to and from the brain, allowing communication between different body parts.
Appendix B: Storyboards (Spinal Cord Anatomy 1–4)
Appendix B: Storyboards (Spinal Cord Anatomy 5–8)
Appendix B: Storyboards (Spinal Cord Anatomy 9–12)

Narration: Spinal nerves branch from your spinal cord. There are 31 pairs of spinal nerves and they are named by the vertebrae they pass through. There are 5 sections of the vertebral column and spinal cord: *cervical*, *thoracic*, *lumbar*, *sacral*, and *coccyx*. Each vertebrae and pair of spinal nerves is given a letter representing its section, C, T, L, S, and Co, and a number.
Visual: sections highlighted

Narration: In your neck there are 7 cervical vertebrae and 8 pairs of cervical spinal nerves. Your cervical spinal nerves are numbered by the vertebrae below them, except C8, which exits below C7 and above T1. The rest of your spinal nerves are numbered by the vertebra above them. Your cervical spinal nerves control your neck, arms, hands, and your main breathing muscle, the diaphragm.
Visual: vertebral columns rotated, zoomed in, partially faded bones when nerves were said

Narration: In your chest there are 12 thoracic vertebrae and 12 pairs of thoracic spinal nerves. Thoracic vertebrae each have a pair of ribs attached. Your thoracic spinal nerves control your trunk and upper abdomen, helping you sit, stand, and breathe.
Visual: moved down, partially faded bones when nerves were said

Narration: In your abdomen there are 5 lumbar vertebrae and 5 pairs of lumbar spinal nerves. Your lumbar spinal nerves control your abdomen and upper legs.
Visual: moved down, partially faded bones when nerves were said
Appendix B: Storyboards (Spinal Cord Anatomy 13–14)
Appendix B: Storyboards (Motor Neurons 1–4)
Narration: Injuries to your spinal cord typically have upper motor neuron injuries or lesions. Injuries to your conus medullaris, the end of your spinal cord, can have a mix of upper and lower motor neuron lesions. Injuries to your cauda equina have lower motor neuron lesions.
Visual: zoomed out, conus medullaris and cauda equina highlighted

Narration: Your upper motor neurons control your lower motor neurons. Your lower motor neurons control the reflexes of your bladder, bowel, sexual organs, and muscles. Whether your injury has damaged upper motor neurons, lower motor neurons, or both, means a lot in the function of your bladder, bowel, and sexual organs.
Visual: cross-section of spinal cord taken, cross-section of spinal cord zoomed into, neuron grown on, bladder faded on

Narration: For example, in an upper motor neuron lesion your bladder will likely have reflex contractions.
Visual: spinal cord faded off, bladder scaled up, bladder filled with urine, bladder contracted

Narration: In a lower motor neuron lesion your bladder will have no tone, and will probably not be able to contract. Knowing what kind of lesion you have allows you to talk with your doctor and find the best lifestyle changes for yourself.
Visual: bladder jerked
Appendix B: Storyboards (Complete vs. Incomplete 1–4)

Narration:

1. Complete vs. Incomplete

2. Spinal Cord Injuries

3. Complete SCI is like cutting the telephone line. The phone call is completely blocked. The terms complete and incomplete describe the function of your spinal cord and the spinal cord damage. If your spinal cord is intact, your signals are not impaired or damaged. Complete SCI may have a lot of movement, but little feeling. Incomplete SCI may have a lot of movement, but little feeling.

4. Incomplete SCI

Visuals:

Complete SCI: moved over, body faded on, signals moved down, tone faded.
Narration: After a spinal cord injury the spinal cord may be bruised or swollen. When the swelling of the spinal cord goes down, the nerves may begin to work again. The motor and sensory level of the injury may change as healing progresses. Depending on the person’s SCI, this recovery may be rapid or slow. It is impossible to accurately predict how much of a person’s sensory or motor function will return and at what speed.

Visual: Icon faded off, body moved over, spinal cord swelled, signals moved through as swelling went down
Appendix B: Storyboards (Autonomic Dysreflexia 1–4)

1. Autonomic Dysreflexia (Hyperreflexia) is a condition in which the spinal cord is injured below the level of the injury. When something happens to your body, such as pressure on the cord, your sympathetic nervous system responds in a protective way. This can lead to AD.

2. AD is most common in people with SCI at T6 or above.

3. AD is a medical emergency, as it can cause severe consequences.

4. Your parasympathetic nervous system is responsible for rest and digest functions.
Appendix B: Storyboards (Autonomic Dysreflexia 5–7)

**5**

**Narration:** It makes you salivate, your digestion increase, and your skin’s blood vessels widen. Your sympathetic nervous system responds in fight or flight situations, stressful situations.

**Visual:** Icon faded off, icons faded on, icons frighten and ran

**6**

**Narration:** It makes your heart beat faster, your skin’s blood vessels narrow, and your pupils widen so you can see better.

**Visual:** Icons faded off

**7**

**Narration:** When something irritates your body below your SCI, signals are sent to your spinal cord to trigger a sympathetic (fight or flight) response. This response narrows your skin’s blood vessels and raises your blood pressure. Your blood pressure will continue to rise until what is irritating your body is stopped. This is why AD is so dangerous. When the irritant’s signal travels up your spinal cord to tell your brain what is wrong, the signal is blocked by your SCI. These signals keep raising your blood pressure, but your brain has no idea why.

**Visual:** Body faded on, sympathetic signal grown up

**8**

**Narration:** Sensors near your heart sense your raised blood pressure and tell your brain that there is a sympathetic response. Your brain does not know why there is a sympathetic response so it sends a parasympathetic (rest and digest) response down your spinal cord to counteract the sympathetic response. The parasympathetic signal from your brain is blocked by your SCI. This means above the level of your SCI your body shows parasympathetic symptoms and below the level of your SCI your body shows sympathetic symptoms.

**Visual:** Parasympathetic signal grown down
Appendix B: Storyboards (Autonomic Dysreflexia 9–12)

Narration: The most common symptom is a sudden pounding headache caused by your raised blood pressure. The strong parasympathetic (rest and digest) response causes you to have a slow pulse, stuffed nose, small pupils, and, above the level of your SCI, flushed, splotchy, and sweaty skin. The small pupils and high blood pressure can cause vision changes such as blurring, seeing spots, and narrowing of vision. Below the level of your SCI the strong sympathtic (fight or flight) response causes your skin to be pale, cool, and covered in goose bumps. Because of the discomfort you may feel nauseous and restless. If left untreated autonomic dysreflexia may lead to seizures, stroke, or death.

Narration: AD requires quick action. It is important to lower your blood pressure, so if possible move into a more upright position and dangle your legs. Remove or loosen any tight clothing or accessories that could be the cause. If possible have someone check your blood pressure to see if it is lowering. Remember that the resting blood pressure for people with SCI’s is lower than it was before the SCI. It is important to take your blood pressure regularly so you know your resting blood pressure. The most important step when you have AD is to find the cause and relieve it.

Narration: Bladder and bowel problems are the most common causes of AD. Skin problems, usually pressure sores, can also cause AD so it is important to regularly check your skin.

Visual: “cause” changed to “Causes” and moved up

Narration: If you are unable to find the problem or relieve it within 5–10 minutes, call 911 for immediate medical assistance. Become familiar with the symptoms, treatments, and causes and make sure these close to you are aware as well. Since not all doctors are familiar with AD it is useful to carry a card about AD in your wallet.

Visual: body faded off
References


Vita

Katelyn McDonald was born March 5, 1990 in Fairbanks, Alaska. She grew up in the small town of Nenana, Alaska, graduating as valedictorian from Nenana City Public High School. In addition to her high school studies, she began taking college classes early because of the limited curriculum of her high school and already established passions for art and science. Attending a Biological Illustration pre-college course at Brown University confirmed her desire to become a scientific illustrator. In 2008, Katelyn began her undergraduate career at Iowa State University (ISU) taking part in their renowned Biological and Pre-Medical Illustration (BPMI) program. At ISU she was an active member of the BPMI club and conducted illustrative and research work in Dr. Lynn Clark's Botanical Systematics Lab. Katelyn graduated in 2012 from ISU summa cum laude with a degree in BPMI and a minor in Biology. She then continued her pursuit of an education in scientific illustration with graduate studies at Johns Hopkins University School of Medicine in the Department of Art As Applied to Medicine. Her studies at Hopkins were generously supported by the William P. Didusch Scholarship. Her poster on the effects of cold-stunning on sea turtles for the National Aquarium was a recipient of an Honorable Mention in the National Science Foundation’s 2013 International Science & Engineering Visualization Challenge. Her Thesis work received a Vesalius Research Grant. Katelyn will be graduating with a Master of Arts in Medical and Biological Illustration on May 22, 2014.